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Conventions Used 

The following conventions are used throughout this manual to indicate mouse and keyboard actions 
and to refer to elements in the user interface. 

Mouse 

Click Press and release the left mouse button. If you are left-handed, 
you may have set the right mouse button as your primary mouse 
button. 

Right-click Press and release the right mouse button. If you are left-handed, 
you may have set the left mouse button as your secondary mouse 
button. 

Middle-click Press and release the wheel button or the middle mouse button. 
If you have a two-button mouse, press and release the left and 
the right mouse button simultaneously. 

Double-click Press and release the left mouse button twice. If you are left-
handed, the right mouse button can be used. 

Keyboard 

CTRL+click Press and hold down the CTRL key on your keyboard while you 
click an object. 

CTRL+O Press and hold down the CTRL key on your keyboard while you 
press O, then release both keys. This example opens the dialog 
window for opening a study. 

Typographical Conventions 

 
On the Segment tab, click 
Apply. 

 
Names of buttons, fields, menus, menu options, and tab names 
are capitalized and in bold. 

 
File > Browse for DICOM… 

 
A sequence of menu options that you select to perform a 
specific task, is indicated by angular brackets. 

 
Double-click New analysis. 

 
Text that you type or that appears on the screen, such as file 
names and file locations, is displayed in Courier New. 
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Symbols Used 

 Reference. Points to related documentation or to related 
sections in the document that may be relevant in your situation. 

 Tip. Provides helpful information or an alternative working 
method. 

 Note. Brings additional information to your attention. 

 Caution. Tells you to be careful when performing a task. 

 Warning. Warns you for a potentially dangerous situation in the 
image representation or analysis, which may lead to incorrect 
results. You are advised to follow the instructions to avoid this. 
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  Introduction 

1 About QIvus Research Edition 

QIvus Research Edition is the Medis software solution for reviewing and analyzing IVUS and OCT 
studies of the coronary arteries.  

QIvus Research Edition enables you to view and analyze both IVUS and OCT studies, including tissue 
characterization as performed by the data provider. QIvus Research Edition currently supports 
Boston Scientific Corporation’s iMap™, Volcano® VH® (Virtual Histology) IVUS, Infraredx TVC™ (True 
Vessel Characterization) tissue characterization and Terumo TCP (Terumo Color Processing). 

 

 

 
The tissue characterization and OCT features are only active in QIvus Research Edition if 
you have the appropriate license(s). 

For IVUS studies, QIvus Research Edition features rapid automatic detection of lumen, stent and 
vessel borders over the entire pull-back run, as well as powerful and intuitive editing, which saves 
you valuable time. Analysis results not only include 2D measurements, but also provide 3D data—
lumen, stent, and vessel volumes. You can print the results in a one-page report or export them for 
further analysis. 

For OCT studies, QIvus Research Edition features fast automatic detection of lumen contours, semi-
automatic detection of stent contours and automatic detection of stent struts. You can export stent 
strut data for further analysis. 
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2 System Requirements 

2.1 Hardware 

QIvus Research Edition: 

• A 32 or 64 bit processor (dependent on the preferred operating system and QIvus version) 

• 8 GB RAM 

• 5 GB free disk space after the software is installed 

• A monitor with a screen resolution of 1.3 Megapixels (e.g. 1280 x 1024 pixel for a display 
ratio 4:3, 1600 x 900 pixels for display ratio 16:9) 

 
Sentinel license server: 

• A 32 or 64 bit processor (dependent on the preferred operating system) 

• 4 GB RAM 

• 2 GB of available hard disk space 
 
NOTES: 

• All hardware must be compliant with the operating system. 

• The requirement for the disk space does not take storage space for image data into 
account. If you want to store images on the local machine, make sure that sufficient disk 
space is available. 

• To view image data a dedicated graphics card supporting OpenGL and at least 512 MB 
memory is recommended. 

• To connect your workstation with other machines in the network (e.g. the license server) a 
network connection will be required. A network interface card supporting at least 100 mbps 
is recommended. 

• For the license server, a workstation with a fixed IP address or a reserved IP address in the 
DNS server is recommended. 

2.2 Operating System 

QIvus Research Edition: 

• Microsoft Windows 7, SP1 or higher, 32 or 64 bit version 

• Microsoft Windows 8.1, 32 and 64 bit version 

• Microsoft Windows 10, 32 and 64 bit version 

• Microsoft Windows 11, 64 bit version 

• Microsoft Windows Server 2016, 64 bit version 

• Microsoft Windows Server 2019, 64 bit version 

• Microsoft Windows Server 2022, 64 bit version 
 

NOTES: 

• To work efficiently with large datasets, it is recommended to work with a 64 bit operating 
system, the 64 bit version of QIvus, and at least 16 GB of RAM. 

• VH data can only be read and analyzed with the 32 bit version of QIvus on Windows 7 or 
Windows 8.1. 
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Medis System Tools and Sentinel license server: 

• Microsoft Windows 7, SP1 or higher, 32 and 64 bit version 

• Microsoft Windows 8.1, 32 and 64 bit version 

• Microsoft Windows 10, 32 and 64 bit version 

• Microsoft Windows 11, 64 bit version 

• Microsoft Windows Server 2008 R2, SP1 or higher, 64 bit version 

• Microsoft Windows Server 2012 R2, 64 bit version 

• Microsoft Windows Server 2016, 64 bit version 

• Microsoft Windows Server 2019, 64 bit version 

• Microsoft Windows Server 2022, 64 bit version 

2.3 Dependencies on Other Software 

QIvus Research Edition is capable of creating detailed reports in Microsoft Excel format. To make 
use of this functionality, the Microsoft Excel software needs to be installed on the machine that 
runs QIvus. The following versions of Microsoft Excel are supported: 

• Microsoft Excel 2010, 32 or 64 bit version 

• Microsoft Excel 2013, 32 or 64 bit version 

• Microsoft Excel 2016, 32 or 64 bit version 

• Microsoft Excel 2019, 64 bit version 

• Microsoft Excel 2021, 64 bit version 

• Microsoft Excel 365 Desktop, 64 bit version 
 

NOTE: 

• Without Microsoft Excel installed on the machine, QIvus Research Edition will still be able 
to perform analyses that can be reviewed on screen, but it will only be able to create 
simple single page reports and print these on paper. 
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3 Support 

For quick and easy QIvus Research Edition support, you can go to the menu bar (on top of the 
program), click Help and choose one of the three options: 

1) User Manual for a simple explanation on all available QIvus Research Edition functions (this 
document). 

2) Instruction Movies for a visual explanation on several topics, including the graphical user 
interface, contour detection, and analysis results. 

3) About… for general package information, like the QIvus Research Edition version number, 
License Information, Legal Notices, and Contact Information. 

 

Medis is committed to offering high-quality products and services. If you have questions about the 
software or if you would like to make suggestions for improvements in the software or in the 
documentation, please contact the Medis helpdesk. 

If you contact the Medis helpdesk by e-mail, mention the name of the software and the version 
number in the subject field.  The QIvus Research Edition version number is displayed in the title 
bar. 

North and South America 

Medis Medical Imaging Systems, Inc. 
E-mail: support@medisimaging.com 
Telephone: +1 919 278 7888 (working days 9.00-17.00 EST) 

Europe, Africa, Asia, and Australia 

Medis Medical Imaging Systems bv 
E-mail: support@medisimaging.com 
Telephone: +31 71 522 32 44 (working days 9.00-17.00 CET) 
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4 Starting QIvus Research Edition and 
Opening Studies 

4.1 Starting QIvus Research Edition 

QIvus Research Edition and its licenses must be installed before you can start the application.  

 

 

 
For instructions on installing QIvus Research Edition and managing licenses, we refer to the 
QIvus Research Edition Installation Manual. 

To start QIvus Research Edition 

• Double-click  on your desktop. 

Or, 

• Select Start > (All) Programs > Medis QIvus Research Edition > QIvus Research Edition 
3.1. 

4.2 Opening Image Runs 

After starting QIvus Research Edition, you open the image run that you want to analyze in the two-
step File Browser as follows: 

To open an image run 

1. Click or select File > Browse for DICOM… 

2. In the Image Browser, browse the directory structure on the left and select the directory in 
which the image run is located. In the right-hand pane, select the image run and click 
Next, or double-click the image run. 

3. In the next step, in the lower pane, select New analysis and click OK, or double-click 

New analysis. 

 
To resume the last analysis, select Last analysis in the lower pane and click OK, or 

double-click Last analysis. 

 
To review or continue an older analysis, select the analysis in the lower pane based on the 
date, time and analyst name and click OK, or double-click the analysis of your choice. 
Analyses created with a previous version of QIvus will be displayed in red. These can still be 
read and modified, but some results may differ because of improved algorithms in QIvus 
Research Edition 3.1. 
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4. If you are loading IVUS grayscale or OCT images, you can limit the number of frames that 
are loaded into QIvus Research Edition in the Image Subset Selection dialog window. With 
large image runs, limiting the number of frames ensures that the image run is loaded 
quickly and that analyses are performed efficiently. You can do this in two ways: under 
Enter Frame Number, select a range of frames to be loaded, or specify a subset selection 
number, which loads just one frame out of the specified number of frames (also known as 
subsampling). 
 

 In case of long pullbacks, it is recommended to load sufficient frames to maintain a 
slice thickness of 0.1 mm or less. 

If you are loading images with tissue characterization data, the data set is limited by 
default to the frames that show tissue characterization. 

5. If the image run is raw OCT, two extra options are present: 

• Radio boxes to switch between loading only the center 7 mm diameter of the 
images and loading the full depth of the image. 

• The checkbox Load Z-offsets. If the image run already has Z-offsets from the 
acquisition system, it is recommended to use those instead of performing the Z-
offset correction later in QIvus Research Edition. 

6. Click OK. QIvus Research Edition now starts to load the image run and creates the 
longitudinal images. 

7. In the General Information dialog window, check the DICOM properties. 
 

 Make sure to check the catheter type, the pull-back speed, and the frame rate. The 
correctness of this information is very important, because it is used to accurately calculate 
the volume measurements and all other measurements in the longitudinal view. 
 
Click OK to close the General Information dialog window. 

4.3 Closing Image Runs 

• Click , when you are done reviewing and/or analyzing the image file. 

• During the closure procedure, all analysis settings and results are automatically saved. 
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5 The QIvus Research Edition Workspace 

The QIvus Research Edition main workspace consists of a menu bar, a set of toolbars and a canvas 
that presents the transversal and the longitudinal views. 

 

 The version number of QIvus Research Edition is displayed in the title bar (not shown in 
screenshot above). 

 The name of the user currently logged on to Windows is displayed in the status bar. 

5.1 Toolbars 

 
Tool Icon 

 
Description 

 
File Toolbar 

 

 

 
Browse for all types of image data that can be read in by QIvus Research Edition 
and start analysis. 

 

 
Close the currently active image file. 

Menu bar 

Toolbars 

Transversal View Longitudinal View 
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Tool Icon 

 
Description 

 

 

 
Save the current image run or part of the current image run as an AVI file, or 
save the currently selected frame or multiple frames as a BMP or JPG file. 

 

 

 
Hide or show the DICOM info. 

 

 

 
Print a one-page report with analysis results. 

 
General Toolbar 

 

 

 
Perform manual calibration and check the catheter and artifact circles. 

 

 

 
Semi-automatically remove calibration markers. 

 

 

 
Automatically remove artifacts. 

 

 

 
Correct for cardiac motion. 

 

 

 
(Re-)creates longitudinal images. 

 

 

 
Specify the segment(s) and/or subsegments of interest for contour detection and 
reporting. 

 

 

 
Hide or show the area graph in the longitudinal view. 

 

 

 
Jump to the frame with the minimum lumen area in the selected segment. 
 

 Click the arrow next to this icon to select other types of frames. For 
example, you can select the frame with the smallest or largest lumen area in the 
current segment, the largest calcium area in the current segment, or the largest 
area of malapposition in the current segment. 
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Tool Icon 

 
Description 

 

 

 
Export the results of the selected analysis to Microsoft® Excel®. 

 

 

 
Open the General Information dialog window, in which you can view and edit 
basic details about the patient, intervention, catheter and stent. 
 

 The changes you make to the properties are only stored with the QIvus 
Research Edition analysis results, not in the original DICOM file. Your changes are 
stored with the current analysis and shown in reports. 

 

  

 
Open the Settings dialog window.  

In this dialog window, you can specify the scroll step and the loop interval. 
 
The other settings in this dialog window show the characteristics of the image run 
as detected by QIvus Research Edition. The contour detection is optimized for 
each specific catheter type. 

 

 

 
 

 
Open the guidewire detection dialog window for iMap or VH-Revolution IVUS 
images. 

 

 
 
or  
 

 
 
or 
 

 

Or 

 

 
Hide or show iMap, VH, TVC or TCP IVUS tissue characterization. 
 

 One of these icons is active if you have the appropriate license, if an image 
run set of the corresponding IVUS manufacturer is loaded, and if tissue 
characterization data and contours are available. 
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Tool Icon 

 
Description 

 

 
 
or 
 

 
 
or  
 

 

Or 

 

 
Display iMap, VH, TVC or TCP IVUS tissue characterization data or re-perform 
tissue characterization. 
 

 One of these icons is active if you have the appropriate license, if an image 
run set of the corresponding IVUS manufacturer is loaded, and if tissue 
characterization data is available for the image run. 

 

 
 
or 
 

 
 
or 
 

 

 
Open the tissue characterization options of the iMap Analysis, VH IVUS Analysis, 
TVC Chemogram Analysis or TCP Analysis dialog window, respectively. 
 
Using the options in this dialog window for iMap, VH or TCP, you can add a pie 
chart and a legend to the transversal view, you can change the transparency of 
the tissue characterization overlay, and you can select the tissues that must be 
shown in the overlay. 
 
If you are reviewing iMap or VH-Revolution images, you can also filter out black 
pixels using this dialog window, you can display the level of confidence with 
which the pixels are characterized as belonging to a tissue type, and you can 
mask specific areas. 

If you are reviewing TVC data, you can view the chemogram map and crosshair 
information, and you can detect the mxLCBI. 

If you are reviewing TCP data, you can set values for start position, gain , noise 
correction, smoothing and purple threshold. 
 

 One of these icons is active if you have the appropriate license, if an image 
run set of the corresponding IVUS manufacturer is loaded, and if tissue 
characterization data is displayed. 

 

 

 
Open the OCT analysis dialog window. 
 

 This icon is only active if you have the appropriate license. 

 

 

 
Open the Loop Viewer window. 
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Tool Icon 

 
Description 

 

 

 
Open the OCT Raw Loop Viewer window. 

 
Analysis Toolbar 

 

 

 
Indicate that you want to create or edit vessel contours. 

 

 

 
Indicate that you want to create or edit stent contours. 

 

 

 
Indicate that you want to create or edit lumen contours. 

 

 

 
Detect longitudinal contours in the segment(s) of interest. 

 

 

 
Detect transversal contours in the segment(s) of interest. 

 

 

 
Detect a transversal contour in a single frame. 

 

 

 
Place a correction point and correct the currently active contour in only the 
current transversal image. 

 

 

 
Undo your changes to the positions of the attraction points. 

 

 

 
Open a dialog window with analysis results.  

Depending on the analyses performed, area, volume, diameter and tissue results 
may be presented. 

 

 

 
Hide or show the transversal contour of the selected contour type. 
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Tool Icon 

 
Description 

 

 

 
Exclude or re-include the current frame in the analysis. 

 

 

 
Undo only the last manual transversal contour edit. 

After use, the icon it becomes inactive until an additional manual edit is applied. 

 

 

 
Open the Delete Contour dialog window, in which you can choose to delete either 
the selected contour in the current frame or in all frames. 

 

 

 
Perform caliper measurement on the transversal image. 

 

 

 
Perform caliper measurement on the longitudinal image. 
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Working With QIvus Research Edition 

6 Reviewing 

6.1 Customizing the Canvas and the Views 

The large canvas gives you space to review the transversal and longitudinal views, which you can 
tile horizontally or vertically. You can also maximize the transversal view or the longitudinal view. 

The following illustration shows a QIvus Research Edition window with maximized canvas and 
vertically tiled views. 

 

To tile the transversal and longitudinal views 

• Select Window > Tile Horizontally or Window > Tile Vertically. 

To maximize the transversal or longitudinal view 

• Double-click the title bar of the view. 
 

To return to the standard view, click  in the upper right corner of the menu bar. 
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6.2 Reviewing Image Runs 

When you review image runs, you use the movie controls and sliders at the top of the transversal 
view and the longitudinal view.  

The sliders are used respectively to select frames, to change the speed with which the image run is 
played, and to zoom in or out. 

 

 Frame Slider Speed Slider Zoom Slider 

To play an image run 

• Click  to start playing the image run. 
 
This plays the image run until the end of the pull-back run and then restarts at the 
beginning. 

• Click  to play the image run backward. 
 
This plays the image run from the end of the pull-back run to the beginning, and then 
restarts at the end. 

6.3 Adjusting Contrast and Brightness 

You can manually adjust the contrast and brightness for the current image run. 

 

 

 
These adjustments only affect the representation on the screen. They do not affect the 
actual image properties or the outcome of the analyses. 

To adjust contrast and brightness 

• In the transversal, longitudinal image or loop view, click the right or middle mouse button 
or the wheel button, hold the mouse button or wheel button down and drag. 

Drag right to increase contrast. Drag left to decrease contrast. 

Drag down to increase brightness. Drag up to decrease brightness. 

To return to the original contrast and brightness settings 

• Double-click the right or middle mouse button or mouse wheel. 
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7 Performing Analyses in IVUS Images 

7.1 Pre-Analysis Actions 

In order to perform an accurate analysis, all analyses should start with a precise calibration and a 
suitable artifact removal of image structures that might diverge the automatic contour detection. 

To check the calibration and remove obstacles for automatic detection 

Normally, the calibration factor is included in the DICOM file. You must check if this information is 
available and in the range you expect, and perform manual calibration if needed.  

If automatic calibration was performed, you must verify that it was performed correctly and that 
any obstacles for the automatic detection have been removed, marked for exclusion, or corrected. 

Next, you must position the catheter circles over the catheter and the artifact circle. This ensures 
that the catheter, the calibration markers, and the artifact areas do not affect the automatic 
contour detection. 

1. Click , and check if the Average calibration factor field shows a calibration factor. If 
it does, click Close and continue with step 3 of this instruction. 
 
If there is no calibration factor or when the calibration factor is not correct, you must now 
manually calibrate the image run. 
 
Browse to the first image that shows the calibration markers. You can do this using the 
Frame slider, which is the first slider in the image control toolbar. 
 
Check the horizontal or vertical marker line in the transversal view to see how long the 
maximum distance is that you can mark. 

2. In the Calibration dialog window, fill in the distance (in mm) under Actual diameter and 
click Indicate distance. 
 
Click and drag in the transversal view, to draw a marker line from the first marker to the 
last marker. Mid- or right-click in the image to accept the calibration line. In the 
Calibration dialog window, click Accept. 
 
Repeat this step for the other marker line, so that the calibration factor is based on two 
distances (one in the horizontal and one in the vertical direction). 

3. Then, in the transversal view, click on the red catheter circle or circle center point to 
activate the catheter circle in the image for editing. Subsequently, you can click and move 
the circle center point to reposition the catheter circle and/or you can click and move the 
catheter circle itself towards the inner- or outer border to resize the catheter circle, until 
the catheter circle is just around the black catheter circle on the white edge. Middle- or 
right-click to accept. 

In the Calibration dialog window, click Ok. 
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4. If the calibration markers are still shown in all images of the image run, click . 
 
Under Horizontal line, click Indicate.  
 
Under Markers, check the number of markers specified and correct it if necessary. If 
needed, adjust the size of the boxes to be drawn around the markers, then click Draw 
markers. This outlines the markers in the images. 
 
Under Vertical line, click Indicate, and repeat the steps for the vertical markers. 
 
Click Remove markers. 
 
This removes the calibration markers from all images except the first. 
 
Click Exit to close the dialog window. 

5. If digital artifact removal has not been performed already and digital artifacts are still 

present in the images, click . 

6. If the image run must be corrected for cardiac motion, click . 

7. By default, QIvus Research Edition creates 16 longitudinal images. If you require fewer or 
more longitudinal images, you can re-create the longitudinal images before you start the 
analysis. 
 

Click . 
 
In the dialog window that opens, select the number of longitudinal images you require. 
Click OK. 

7.2 Performing Caliper Measurements 

QIvus Research Edition enables you to perform various caliper measurements: distance 
measurements, angle measurements, line, and area measurements. These caliper measurements 
cannot be saved or exported. 

To perform a caliper measurement 

1. Select  or  to perform a caliper measurement in the transversal or 
longitudinal view respectively. 

2. Select in the Transversal Caliper dialog window the type of caliper measurement you want 
to perform: Indicate distance, Indicate angle, Indicate line, or Indicate area. 
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Or, select in the Longitudinal Caliper dialog window the type of caliper measurement you 
want to perform: Indicate distance, or Indicate angle. 

3. If you want to measure an angle, pick up and move the measurement overlay in the image 
and position it over the right area. Pick up and drag the angle legs into the correct position. 
This displays the angle in the image and in the dialog window. 
 
If you want to measure a distance, a free-form line length or an area, click to place the 
starting point of the distance measurement in the image, and drag to the end point. 
Release the mouse button. This displays the distance in mm or the area in mm2 in the 
image. 

4. You can add other caliper measurements, or perform the caliper measurement again. 

5. Click Finish to close the dialog window. Note that these measurements are lost when the 
dialog is closed. 

7.3 Performing Single-Slice Analyses 

An analysis in a single slice provides you with a number of 2D analysis results: area and diameter 
results, and a symmetry indicator. With a single-slice analysis, you can focus on the vessel, the 
lumen, or the stented area, or a combination of these areas. 

To perform a single-slice analysis 

1. Open an image run and make sure to start with the pre-analysis actions.  
 

2. Using the movie controls, select your frame of interest. 
 

3. Select the type of contour for which you want to obtain analysis results: a vessel, stent, or 
lumen contour. 
 

 

4. The contour detection needs a circular model that is created manually. Click , then 
click at the center of the contour you want to detect and drag until the circle matches the 
contour as closely as possible. After releasing the mouse button you can still move the 
complete circle by dragging the center point or resize the circle by dragging the outline. 

 Make sure the input model fits in a general manner, because this will improve your 
contour detection and decrease the need for contour editing. 

5. Middle- or right-click to accept the input model. 
 
The contour is now automatically detected.  
 

 To ensure that the analysis results are accurate, all automatically detected contours 
must be reviewed and edited where necessary. 
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6. Click  to view the analysis results for this slice. 
 
The contour and analysis results are saved automatically with the current image run. 

7.4 Performing Segment Analyses 

A quantitative analysis of a vessel segment of interest provides you with area, diameter and 
volumetric analysis results for an entire segment. 

• Open an image run and make sure to start with the pre-analysis actions 

To perform the segment analysis 

1. Indicate your segment of interest using the blue segment marker in the longitudinal view.  
 
 
You can select and drag the end-points of the marker, and you can move the entire marker 
by selecting and dragging the horizontal bar. 
 

 
 

2. If you also want to obtain analysis results for the edge segments and for the reference 
segments, you can add more vessel segments to the analysis. 
 

Click . 
 
In the Segment Definition dialog window, select the check boxes of the segments you want 
to add. 
 
Click Apply, and then click Close. 

The longitudinal view now looks similar to the following. 
 

 

3. If you want to obtain analysis results for subsegments of the segment of interest, you can 
define the subsegments. Results for the subsegments are included in the MS Excel report. 
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Click . 
 
In the Segment Definition dialog window. If the list of subsegments is not shown, click 
Define subsegments to show it. Press Add to add a subsegment. 

Enter the start frame and end frame of each subsegment. You can also enter a name for 
each subsegment, or select it from the drop-down list. 

 When identical frames are used as start and end frame, the (sub)segment can have a 
segment length of 0.00mm. 

Click Close. 

4. Select the type of contour for which you want to obtain analysis results: vessel, stent, or 
lumen contours. 
 

 
 
By default, the vessel contour is selected. 

5. Click . 
 
This detects the longitudinal contour in the segment of interest. 

6. Review the attraction points (represented by small green circles) in the transversal view by 
dragging the cross-sectional (red) marker line 
through the entire segment in the longitudinal 
view.  
 
You can move an attraction point by picking it up 
in the transversal view and dragging it to its new 
location. At the same time, an attraction point is 
added to its new location in the longitudinal 
view, and followed with a redetection of the 
longitudinal contour, whereby the new 
longitudinal contour is obliged to go through (all) 
the added attraction point(s); a global editing 
effect. 
 

7. Click . 
 
This detects all the transversal contours in the segment of interest. 

8. Review the transversal contours in the entire segment.  
 
You can do this in three ways: 1) drag the Frame slider in the transversal view, 2) review 

the area graph in the longitudinal view, or 3) click the arrow next to  and select 
e.g. Smallest vessel area in segment, and then Largest vessel area in segment. 
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9. Edit the contours in the transversal view if needed.  
 

 To ensure that the analysis results are accurate, all automatically detected contours 
must be reviewed and edited where necessary. 

10. If needed, repeat steps 4 through 9 to obtain the stent contours and then the lumen 
contours,  (or in case of Volcano Eagle-Eye, the vessel contours and then the lumen 
contours). 

11. You can define specific frames of interest. 

The user-defined frames of interest are included in the Excel report, in which they replace 
the by default used frames. 

• Select Options > Define frames of interest to open the Frame navigation dialog 
window. 

• Press on one of the Go to buttons, to immediately go to the retained transversal or 
longitudinal frame. 

• Select a specific transversal frame and press D (Define) on the corresponding Go To 
transversal frame type (i.e., Distal, Segment, and Proximal) to retain.  

You can select a specific longitudinal frame as well, by pressing D on the corresponding 
Go To longitudinal frame type (i.e., Long 1 or Long 2) retain. 

Press R (Remove) to release the corresponding specific frame. The placeholder for this 
image in the Excel report will be empty. 

12. You can view the analysis results by clicking . 
 
The contours and analysis results are saved automatically with the current image run. 
 
You can export a frame, part of the image run or the entire image run as a BMP, JPG or AVI 
file. You can also print a report or export the results to MS Excel.  

7.5 Editing Contours 

There are three ways to edit.  

• you can move an attraction point 

• you can insert a correction point that forces the contour through a specific location 

• you can manually re-trace part of the contour 

Moving an attraction point is the most powerful editing option. This redetects the longitudinal and 
transversal contour. 
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To move an attraction point 

1. Pick up and drag the attraction point in the transversal view to its new location. 
 
This redetects all (longitudinal and transversal) contours near the attraction point. 

2. To undo your manual attraction point change in the transversal view one by one, click 

. 

To insert a correction point 

1. Click  or press C, and then click in the transversal view to place the correction 
point. 
 
The contour snaps to the correction point. 

2. If you are not satisfied with the new transversal contour, you can pick up the correction 
point and drag it to a new location. 
 
You can selectively remove the correction point by clicking it with the left and right mouse 
button simultaneously. 

To manually re-trace part of a contour 

1. Select the transversal contour and start re-tracing the contour using the left mouse 
button, and release to accept the manually corrected part of the contour. 

2. The longitudinal contour can be manually corrected as well. Select the longitudinal 
contour, start re-tracing the contour (in fact you reposition the contour points / attraction 
points), and release to accept. Because the positions of the corresponding attraction points 
in the transversal view are changed, the transversal contours will be redetected.  

Redetecting longitudinal contours 

If you are not satisfied with your manual edits of the longitudinal contour or support points in the 

transversal image(s), you can redetect the selected longitudinal contour by clicking . The 

actual effect depends on the options "Multiple longitudinal vessel", "Multiple longitudinal lumen" 
and "Multiple longitudinal stent" that can be set via the main menu (Options).  When the option is 
ON, the contours in all the 4 predefined longitudinal views are updated. When the option is OFF,  
only the two contours in the current longitudinal view are updated (one cross-section). The first 
option (ON) is useful when user wants to redo the entire contour detection. The second option 
(OFF) can be useful when additional support points are needed in the transverse image, in case of 
poor image quality or difficult analyses. 
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8 Viewing Tissue Characterization 

QIvus Research Edition can display tissue characterization overlays in image runs that provide this 
information. Currently, QIvus Research Edition supports Boston Scientific iMap, Volcano VH IVUS, 
Terumo Color Processing (TCP) and Infraredx TVC tissue characterization. 

 

 

 
Viewing Boston Scientific iMap, Volcano VH-Eagle Eye IVUS, Volcano VH-Revolution IVUS, 
Infraredx TVC, and Terumo TCP data sets requires special licenses. 
 
Contact your Medis account manager or send a mail to sales@medisimaging.com for more 
information. 

If you are reviewing iMap, VH, TCP or VH-Revolution data sets, you can change the level of 
transparency of the tissue overlay and hide individual tissue types from the overlay. In the 
transversal view, you can also add a legend and a pie chart. 

If you are reviewing iMap data sets, you can display the confidence level of the tissue types with 
the brightness of the pixels color and exclude low or high confidence pixels from the tissue 
characterization results. 

If you are reviewing iMap or VH-Revolution data sets, you can also filter out guidewire pixels (low-
intensity pixels) from the tissue characterization results. 

The following images show examples of a transversal view with Volcano’s VH IVUS and Boston 
Scientific’s iMap IVUS tissue characterization, respectively. 

   
VH tissue characterization iMap tissue characterization 

Next image shows an example of Terumo Color Processing 
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Terumo Color Processing 

If you are reviewing Infraredx TVC images, the TVC Chemogram Analysis will display the 
Chemogram map in which you can automatically detect the maximal LCBI (Lipid-Core Burden 
Index). 

The first of following images shows an example of a transversal view with Infraredx TVC tissue 
characterization with its chemogram Halo around the gray scale IVUS image. In the center of the 
image (inside the catheter artifact) you can see the Block-Index chemogram circle. 

  

The second image shows an example of the longitudinal view with Infraredx TVC tissue 
characterization, with in the middle of the image the Block-Index chemogram bar that corresponds 
to the Block-Index chemogram circle. The colored bars at top and bottom of the image correspond 
to the chemogram Halo in the transversal view. 
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To view tissue characterization 

1. Open the image run with tissue characterization. 
 
In the File Browser, the image run preview is marked iMap, VH, VH-Revo or TVC if tissue 
characterization is available. The following illustrations show examples. 
 

     

               

2. When the gray-scale images are loaded in QIvus Research Edition, click , , 

 or . 
 
This displays the tissue characterization in the transversal and longitudinal views. If no 
lumen and vessel contours were previously detected on QIvus Research Edition, this also 
loads contours that were created on the acquisition system (not applicable for TVC and 
TCP). 

 In case the contours were created on the Boston Scientific’s iLab system, the labels 
iLab Lumen (in red) and iLab Vessel (in green) are displayed in the top left corner of the 
transversal view. 

 In case the contours were created on the Volcano VH IVUS imaging system, the labels 
s5 Lumen (in red) and s5 Vessel (in green) are displayed in the top left corner of the 
transversal view. 
 

 If the tissue characterization is not displayed, no lumen and vessel contours from the 
acquisition system were available. Detect lumen and vessel contours in QIvus Research 
Edition first. We refer to section 7 for instructions. 

To hide or show tissue characterization 

You can temporarily hide the tissue characterization to view the underlying images. 

• Click , ,  or  to hide the tissue characterization. 
 
Click the icon again to show the tissue characterization. 
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9 Performing Analyses in OCT Images 

QIvus Research Edition can automatically detect stent struts in raw St. Jude Medical OCT and raw 
Terumo OFDI image data. Additionally, QIvus Research Edition can read, display and perform 
manual analyses on St. Jude Medical (formerly known as LightLab) Optical Coherence Tomography 
(OCT) and Terumo Optical Frequency Domain Imaging (OFDI) raw and DICOM image data. 
Additionally,. 

 Performing analyses in OCT images requires a special license. 

Contact your Medis account manager or send a mail to sales@medisimaging.com for more 
information. 

The following image shows an example of an OCT analysis. 

 

To change the display color of the OCT image run 

By default, St. Jude Medical OCT image runs are displayed in "gold" color. You can change this to 
grayscale or inverted grayscale.  

By default, Terumo OFDI image runs are displayed in grayscale. You can only change this to 
inverted. 
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• Click  to open the OCT Analysis Dialog window and select the Stent strut points 
Tab. 
 
Go to the View Mode box at the bottom of the window, select Grayscale,  Inverted or 
Color, and then click Close. 

9.1 Pre-Analysis Actions OCT 

To perform z-offset correction 

In OCT image runs, the z-offset in the transversal images can change over the length of the image 
run. You can correct for this change using the z-offset correction. 

1. Select Options > Change Z-offset.  

This opens the z-offset dialog window. 

2. Go to the first distal frame of the image run. 

3. Usually, the appropriate sheath size is given by default. 

However, if it is necessary, change the sheath size at Size of the sheath into the 
appropriate one, and click Change circle to accept. 

4. In the transversal view, pick up the center of the circle and move the red circle over the 
guiding sheath in the image until their centers coincide. 

5. Use the slider to change the Z-Offset such that the guiding sheath and red circle coincide. 

6. Click Update. This updates all images from the first frame to the end frame of the image 
run with the present z-offset factor zero. 

7. Scroll through the image run from start to end and check whether the sheath keeps fitting 
the red circle. Stop scrolling when there is no fit anymore. 

Enter a z-offset correction factor at Z – Offset and click Test to show the correction in the 
current frame, or drag the slider to change the z-offset correction factor until there is a 
perfect fit of the outer edge of the guiding sheath against the circle again. 

8. Click Update. This updates all images from the current frame to the end of the image run 
with the new z-offset factor. 

9. Click Close when the end frame is reached. 

9.2 Performing OCT Analyses 

QIvus Research Edition supports the analysis of metal stent struts as well as the struts of a 
biodegradable vascular scaffold (BVS).  

• Metal stent struts:  

o Represented by a single point in the transversal image. 
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o Typically only one stent contour is detected per frame. Abluminal distance from 
strut is configurable in the settings (see section 9.1) 

• BVS struts: 

o Represented by a small box-shaped area in the transversal image 

o Typically two stent contours are detected per frame: one that touches the 
adluminal side of the strut boxes and one that touches the abluminal side of the 
strut boxes.  

To automatically detect stent struts 

1. Indicate your segment of interest (stent segment) by using the blue segment marker in the 
longitudinal view or use the Segment Definition dialog window to fill in the start- and end 
frame.  

2. Click  to open the OCT Analysis Dialog window and select the Stent strut points 
Tab. 

3. In the dropdown list at the top of the Struts box, you can select the type or stent you want 
to analyze: Metal, BVS Follow-up, BVS Baseline. 

4. In order to detect BVS struts, first press Detect all lumen contours. 

5. To start the automatic stent strut detection in the target segment, click All frame strut 
detection in the Struts box. 

The struts are detected in all frames of the target segment of the transversal view. 

6. All the detected stent struts are listed in the Struts table. 

To manually add, edit and delete stent struts 

1. Click  and select the Stent strut points Tab. 

2. Use the Frame slider to scroll through the image run in the transversal view. Browse to the 
image that you want to analyze. 

3. Before setting BVS strut points, make sure the lumen contour is present, e.g. by pressing 
Detect lumen contour or Detect all lumen contours. 

4. To add a stent strut marker point, click Add struts manually in the Struts box of the Stent 
struts points Tab, then click to place the new point or points in the transversal image. 
Middle- or right-click to accept your strut point edits (yellow color becomes white). 

5. To edit the position of a stent strut marker point, select the target point in the transversal 
image (color becomes yellow) and drag it to a new position. Middle- or right-click to accept 
your strut point edits (color becomes Blue). 

6. To edit the shape of a BVS stent strut marker, click on its contour and draw the change. It 
might be useful to zoom-in as the struts are quite small. 

7. To delete a stent strut marker point, select its Strut nr in the strut list from the Struts 
table and click Remove strut. 
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To add stent strut descriptions 

Strut descriptions are shown in the results pane and in reports. The strut descriptions also define 
the color of the strut points in the transversal image and in the 2D view. By default there are four 
descriptions to choose from: Covered (green), Uncovered (yellow), Malapposed (red) and Artefact 
(blue). 

Add stent strut descriptions automatically 

As of version 3.1 QIvus Research Edition can label the struts automatically. First make sure the 
settings are to your liking: 

1. Click  and select the Settings Tab. 

2. In the section for Strut thickness there are two options that affect the automatic strut 
labelling: 

a. Minimal malapposition distance in mm. 
If the strut is inside the lumen and the distance to the lumen contour is larger than 
this value, it will be labelled “Malapposed”. 

b. Minimal coverage distance in mm. 
If the strut is more than this distance from the lumen, it will be labelled “Covered”. 

3. Select the Stent strut points Tab 

4. Make sure that in the OCT dialog, both lumen as stent contours have been detected. 

5. Click the Label struts button to perform the automatic strut labelling. 

6. After the automatic labelling, you can always change the labels manually. (See next 
section) 

To show or hide stent strut descriptions in the transversal view 

You can show the stent strut descriptions you have added in the image, or hide them again. 

• In the Stent strut points Tab, click Show Labels in the Graphics box. 
 
This changes the text on the button to Hide Labels.  

• Click Hide Labels to hide the descriptions from the view. 

To lock or unlock strut points 

You can lock the positions of the stent strut points, to make them un-editable during the stent 
contour editing process. 

In the Stent strut points Tab, check Lock strut points in the Struts box. 

• To enable the editing of the stent strut points, un-check Lock strut points. 

To detect the stent and lumen contours 
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 Although the IVUS longitudinal and transversal contour detection buttons are active during OCT 
analysis, the user should be aware that the processing of the IVUS and OCT contour detection is 
very different (e.g., with respect to attraction points, kernels, contour smoothing, etc.). 
Therefore, it is not advised to use the IVUS contour detection for the OCT analysis, unless the 
vessel is filled with blood. 

• Click  and select the Stent strut points Tab. 

• Click Detect stent contour in the Contours box. 
 
This creates a spline fit contour through the stent strut markers. 

• Click Detect lumen contour. 
 
This performs the contour detection and adds the analysis results to the Struts table. 

You can re-use the indicated correction points, when you want to redetect the stent contour(s). 

• In the Stent strut points Tab, check Keep correction points in the Contours box. 

To edit the stent and lumen contours 

You can edit the transversal contours by placing correction points and by manually redrawing part 
of the contour. 

1. Click , or  to specify the contour type you want to edit. 

2. Now you can edit the contour in 3 ways: 

o By placing a correction point: Press the C key on your keyboard and then click at 
the right location in the transversal image. 

o By removing a correction point: Press the left mouse button down on the point in 
the transversal image and then click the right mouse button. 

o By manually redrawing part of the contour: Click and hold left mouse button on the 
contour and then move the mouse. Release the mouse button to accept the change.  

To delete the stent and lumen contours 

The OCT stent and lumen contours can be deleted. 

1. Click , or  to specify the contour type you want to delete. 

2. Next, click  to open the Delete contour window. 

The opened Delete contour window shows the selected contour type.  

3. Specify if you want to Delete current transversal contour, Delete multiple contours or 
Cancel. 
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To show or hide the areas inside and the areas outside the stent 

You can show all the plaque areas inside the stent and the lumen areas outside the stent in the 
transversal view. 

• In the Stent strut points Tab, click Show lumen - stent in the Graphics box. 
 
This marks the areas inside in green and the areas outside in red in the transversal view. It 
also changes the text on the icon to Hide lumen - stent.  

• Click Hide lumen – stent to hide the areas from the view again. 

To show or hide lines between the lumen and the struts 

In the transversal view, you can also display lines that run from each stent strut to the lumen. 

• In the Stent strut points Tab, click Show lumen - strut in the Graphics box. 
 
This adds the lines to the transversal view. It also changes the text on the icon to Hide 
lumen- strut.  

• Click Hide lumen – strut to hide the lines from the view again. 

To show or hide the strut lines of the area between the struts 

In the transversal view, you can display strut lines that run from the struts to the center of the 
stent contour. 

• In the Stent strut points Tab, click Show strut lines in the Graphics box. 
 
This adds the lines to the transversal view. It also changes the text on the icon to Hide 
strut lines.  

• Click Hide strut lines to hide the lines from the view again. 

To view stent strut statistics 

1. Click  to open the OCT Analysis Dialog window and select the Stent strut statistics 
Tab. 

2. When stent struts are detected, the following data will be shown: the Nr. of frames with 
struts, the Tot. nr. of struts, and the Average nr. of struts per frame. 

3. When the lumen contours are detected, the following data will be shown: the Nr. of struts 
with positive distance and the Nr. of struts with negative distance. 

4. When strut descriptions are added, the Nr. of struts per label table will show: the Number 
of struts per strut description and the Percentage of struts per strut description. 
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To view a 2D representation of the stent struts (carpet view) 

1. Click  to open the OCT Analysis Dialog window and select the 2D Tab. 

2. Click the Show struts button => Dots will appear in the black area. Note that for each 
change in the settings of this tab, you need to click the Show struts button to see the 
effect. 

3. Use stent center (followed by Show struts): Default, the catheter center  is used to 
resample the image into 360 degrees. When the option “Use stent center” is selected, the 
center of the stent is used. Especially when the catheter is eccentric, this gives a better 
image with respect to the strut distribution. If no stent contour is present, but the lumen is 
present, the lumen center is used. If both are absent, the catheter is used 

4. If the struts have been labeled, the struts are shown in color. These colors correspond to 
the ones you see on the tab Stent strut statistics and in the transversal image. You can 
switch to white spots by selecting Show in white, followed by Show struts. 

5. You can save an image of the 2D view as .png by clicking Save image. 

9.3 Performing OCT Caliper Measurements 

To add distance measurements 

This measurement tool can be used to determine individual distances, such as the distance of the 
stent strut towards the lumen edge (e.g., malapposed stent strut) or the plaque thickness (e.g. of 
plaque covered strut). 

1. Click  to open the OCT Analysis Dialog window and select the Measurements Tab. 

2. Use the frame slider to scroll through the image run in the transversal view. Browse to the 
image in which you want to measure. 

3. For administrational purposes, you are able to specify on which strut number the distance 
measurement is performed on. Browse Measurements on to select the corresponding Strut 
number, or Frame when the distance measurement is not linked to a strut. 

4. To add a distance measurement, click Add Distance in the Distance measurements box, 
then indicate the start position in the transversal view by pressing the left mouse button, 
draw a line and release the left mouse button at the end position in the image. 

5. To edit a distance measurement, click on the start- or end point of the distance line and 
drag it to a new position. Release mouse to accept. 

6. To delete a distance measurement, select it in the list of the Distance measurements 
table and click Remove selected distance(s). 

To add distance measurement descriptions 

Distance descriptions are shown in the results pane and in reports. For the Strut related distance 
descriptions you can choose by default from: Abluminal and Adluminal, and for the Frame related 
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distance descriptions you can choose by default from: Abluminal, Adluminal, Rupture and 
Sidebranch. 

• In the Measurements Tab, select a Distance Nr in the Distance measurements table, and 
then select a description from the description drop-down list, or right-click on a Distance 
Nr in the list and select a description in the displayed menu. 

To add area measurements 

This measurement tool can be used to determine individual areas, such as the area of the stent 
strut (e.g., biodegradable stent) or the plaque size (e.g. of plaque covered strut). 

1. Click  and select the Measurements Tab. 

2. Use the Frame slider to scroll through the image run in the transversal view. Browse to the 
image that you want to measure. 

3. For administrational purposes, you are able to specify on which strut number the area 
measurement is performed on. Browse Measurements on to select the corresponding Strut 
number, or Frame when the area measurement is not linked to a strut. 

4. To add an area measurement, click Add Area in the Area measurements box, then click in 
the transversal image to indicate the start position. Draw the contour and release the 
mouse button at the end position of the area contour. Subsequently middle-click to close 
and accept the area contour. 

To edit an area measurement, click on the part of the contour that needs editing and re-
draw the area contour. Middle- or right-click to close and accept the edited area contour.  

To delete an area, select it in the list of the Area measurements box and click Remove 
selected area(s). 

To add area measurement descriptions 

Area descriptions are shown in the results pane and in reports. For the Strut related area 
descriptions you can choose by default from: StentArea, AbluminalPlaque and AdluminalPlaque, 
and for the Frame related distance descriptions you can choose by default from: Thrombus, 
Calcified, LipidPool, Artefact, GuideWire, FalseLumen and NecroticCore. 

• In the Measurements Tab, select an Area Nr in the Area measurements table, and then 
select a description from the description drop-down list, or right-click on an Area Nr in the 
list and select a description in the displayed menu. 

To add angle measurements 

This measurement tool can be used to determine individual angles. 

1. Click  and select the Measurements Tab. 

2. Use the Frame slider to scroll through the image run in the transversal view. Browse to the 
image that you want to measure. 
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3. Make sure that Frame is detected in the dropdown after Measurements on:  

4. To add an angle measurement, click Add angle in the Angle measurements box. A default 
angle is drawn. 

5. Edit the angle by dragging its arms or center. Middle-click to close and accept the angle. 

To delete an angle, select it in the list of the Angle measurements box and click Remove 
selected angle(s). 

To add angle measurement descriptions 

Angle descriptions are shown in the results pane and in reports.  

• In the Measurements Tab, select an Angle Nr in the Angle measurements table, and then 
select a description from the description drop-down list, or right-click on an Area Nr in the 
list and select a description in the displayed menu. 

9.4 Performing Thin Cap Analysis 

The option to perform cap measurements is a semi-automatic procedure. The user is responsible for 
selecting the location of the fibrous cap and then the software automatically determines the 
distances between both contours, translated as thickness. 

1. Click  to open the OCT Analysis Dialog window and select the Cap measure dialog 
Tab. 

2. Use the frame slider to scroll through the image run in the transversal view. Browse to the 
image in which you want to measure. 

3. Make sure the lumen contour is present. If there is no lumen contour present, detect the 
lumen contour by pressing Detect lumen and correct it if necessary. 

4. Next indicate the start and end angle of the fibrous cap by pressing Indicate cap. A default 
angle is drawn in the transversal image, typically with arms at the wrong location, so: 

5. Modify the two “legs” of the triangle by selecting the endpoints with the left mouse point 
and move it to the appropriate position. The part indicated by the yellow arc, is the region 
of interest. 

6. Next press the Detect cap button to get the abluminal cap contour. 

7. This contour can be modified by selecting it with the left mouse button and redrawing parts 
with the left mouse button hold down. 

8. The image shows also a red and a green line between. The red one is the shortest distance 
between the lumen and the cap contour, the green line is the largest distance between the 
lumen and cap contour. The distance between the contours is based on the shortest 
distance to the other contour based on individual points. 

9. Multiple caps can be drawn in one image. 

10. To delete a cap, select it in the dialog and then click Delete cap. 
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11. In case a guide wire is defined, the guide wire region is excluded from the thickness 
measurements. 
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10 Creating Reports 

10.1 Printing a One-Page Report 

You can print a one-page report for inclusion into a patient’s file. The report contains patient and 
study details, and analysis results. It also provides fields for comments, approval signature and 
date. 

To print a one-page report 

• Select File > Print… to open the Print dialog window. 

Or, 

• Click  to directly print the one-page report. 

10.2 Customizing Image Display in Reports 

You can customize how some of the image elements are displayed in images in the one-page 
reports and in the MS Excel reports. 

You can modify the colors used for the vessel, lumen or stent contours and for the slice indicators 
that mark the proximal, target, and distal slices in the image. You can also change the thickness of 
the contour lines, and hide any of the detected vessel, lumen or stent contours, or show the slice 
indicators.  

The changes you make only apply to the currently selected image run. 

To customize image display in reports 

1. Select Options > Print Options. 

1. In the IVUS Print Options dialog window, remove the check mark from the Visible check box 
for the Vessel Contour, Lumen or Stent options. The slice indicators that mark the 
proximal, target, and distal slices are hidden by default. 
 
Under Print Color you can select another color for the various contours. 
 
After Line you can select a different contour line thickness. 

2. Click OK. 
 
This instantly applies your changes. 
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11 Exporting Results 

11.1 Export Images and Image Runs 

You can export the current image run or part of the current image run as an AVI file, or export the 
currently selected image or multiple images as a BMP or JPG file. 

You can choose to save contours with the images, and gray-scale or tissue characterization images. 

To export an image or image run 

1. Select the transversal or longitudinal view, to specify image view frames that need to be 
exported. 

2. Click  or select File > Save… 
 
This opens the Save As dialog window. 

3. The directory shown by default is the directory in which the image run is stored. 

4. Type a name for the image or image run in the File name field, select the file format from 
the Save as type field, and click Save. 
 
This opens a dialog window, in which you can indicate if you want to save a single image or 
the entire image run (BMP or JPG) or part of the image run or the entire image run (AVI). 
You can also choose to save contours or tissue characterization with the images. 

Click Save. 

11.2 Exporting Results 

To export results to Excel 

You can export your QIvus Research Edition results to Microsoft Excel for further analysis.  

1. Click . 
 
This starts the export process and opens the Save As dialog window. 

2. Type a name for the Excel report file in the dialog window, and click OK. 
 
This creates the Excel spreadsheet and displays it. 

To modify the cross-sectional area graph settings 

1. Select the OrgSheet Tab. 
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2. Click Graph Settings. 

This opens the Select Graphs to Display dialog window. 

3. Select the graph lines that need to be displayed in the Cross-Sectional Area graph. 

There are eight graph lines to choose from: Vessel CSA, Lumen CSA, Stent CSA, Vessel 
CSA-Lumen CSA, Vessel CSA-Stent CSA, Stent CSA-Lumen CSA, Abluminal Stent CSA and 
Reference CSA. See the legends for the colors. 

To define the reference area method 

1. Select the OrgSheet Tab. 

2. Click Reference Area. 

This opens the Select References Area Method dialog window. 

3. Select the reference area calculation method you want to use. 

There are eight calculation methods to choose from: Interpolation using Proximal and 
Distal Vessel Areas, Average of Distal Vessel Areas, Average of Proximal Vessel Areas, 
Interpolation using Proximal and Distal Lumen Areas, Average of Distal Lumen Areas, 
Average of Proximal Lumen Areas, Vessel Area at same location as Lumen Area, and 
Interpolation of Vessel Areas in Analyzed Part only. 

To define the remodeling index method 

1. Select the OrgSheet Tab. 

2. Click Remodeling Index. 

This opens the Select Remodeling Method dialog window. 

3. Select the remodeling index calculation method you want to use. 

There are three calculation methods to choose from: Interpolation using Proximal and 
Distal Vessel Areas, Average of Distal Vessel Areas, and Average of Proximal Vessel 
Areas. 

4. Select the position where you want to calculate the remodeling index for. 

There are two positions to choose from: At position of minimum lumen area (MLA) and At 
position of maximum area stenosis.  

The remodeling index data is displayed in the Reference Area Calculation Based on Vessel 

Area at Same Location as Lumen Area box. 

To select result pages to print 

1. Select the OrgSheet Tab. 

2. Click Print Results. 

This opens the Select Pages to Print dialog window. 
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3. Select the pages you want to be printed. 

There are six pages to choose from, that refer to the Excel Tabs: “OrgSheet”, “Images”, 
“Edge Segments”, “TissueAnalysis”, “TissueImages”, and “OCTResults”. 

4. Click All Pages or Selected Pages to print. 
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